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WSTEP

1. WSTEP

1.1. PODZIEKOWANIA

Dziekujemy za zakup audiometru marki Amplivox. Otosure jest kompaktowym, automatycznym audiometrem,
sterowanym i kontrolowanym przez komputer.

Otosure jest uzywany z oprogramowaniem Amplivox Audibase, ktére umozliwia przechowywanie zapiséw badan na
komputerze, kategoryzowanie audiograméw, drukowanie audiograméw i wymiane danych z innymi aplikacjami
komputerowymi.

Niniejsza instrukcja obstugi umozliwia petne i bezpieczne korzystanie z funkcji oferowanych przez audiometr Otosure.
PROSIMY O DOKEADNE PRZECZYTANIE INSTRUKCJI przed uzyciem audiometru.

1.2. PRZEZNACZENIE

To urzadzenie jest przeznaczone do uzytku wytgcznie przez przeszkolony personel, taki jak audiolodzy, laryngolodzy,
lekarze, lekarze ogdlni, dystrybutorzy aparatéow stuchowych, pracownicy ochrony zdrowia dzieci i protetyki stuchu o
podobnym poziomie wyksztatcenia. Nie zaleca sie uzywania sprzetu bez niezbednej wiedzy i przeszkolenia.

1.3. PRZECIWSKAZANIA

Przed badaniem nalezy zawsze wzrokowo sprawdzi¢ ucho zewnetrzne i przewdd stuchowy zewnetrzny pod katem
nieprawidtowosci. Nie nalezy przeprowadzac testow w nastepujacych przypadkach:

1. Wystepowanie nadwrazliwosci na gtosne dzwieki moze by¢ przeciwwskazaniem do badania w przypadku
stosowania bodZzcéw o duzym natezeniu.

2. Niedawno przeprowadzona operacja ucha zewnetrznego.

1.4. AKCESORIA STANDARDOWE | OPCJONALNE

Dokumenty przewozowe zawierajg numery referencyjne towaru oraz wizerunek czesci z odpowiadajgcym numerem
magazynowym dostepnego s na stronie internetowej Amplivox (www.amplivox.com). Odpowiednie instrukcje
montazu sg dostarczane z kazdg akcesorium.

AKCESORIA STANDARDOWE
Audiometr Otosure 8508019 Stuchawki audiometryczne (DD45) 8509615
Przycisk reakcji pacjenta 8011155 HBA audiometryczna opaska 8010882
Kabel USB A to USB B (2.0 m) 8011241 Pokrowiec 8004651
Certyfikat kalibracji USB z oprogramowaniem Audibase oraz 8510705 and
instrukcjami uzytkowania 8510707

(OSHA)
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AKCESORIA DO PONOWNEGO ZAMOWIENIA

Audiocups (stuchawki redukujgce hatas) 8010855
Audiocup poduszki nauszne 8010835
Audiocup opaska 8507381
Audiocup ostona na opaske 8010834
Booth Leads 851095

Standardowe stuchawki

Poduszki do sluchawek

Stuchawki DD45 *

Przewdéd zestawu stuchawkowego

WSTEP

8010840
8010857
8010876
8010822

Akcesoria oznaczone * wymagaja kalibracji z okreslonym audiometru. Nie nalezy uzywa¢ tych akcesoriéw dopdki

audiometr nie zostanie skalibrowany.

1.5. OSTRZEZENIA

W instrukcji obstugi majg zastosowanie nastepujgce oznaczenia ostrzezen i przestrog:

ktére mogg stwarzac zagrozenie dla pacjenta i/lub uzytkownika.

. Znak OSTRZEZENIE informuje o takich warunkach i zastosowaniu w praktyce urzadzen,
OSTRZEZENIE

UWAGA

mogg spowodowac uszkodzenie sprzetu.
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ZASADY DZIAtANIA

2.ZASADY DZIAtANIA

2.1. BADANIE OTOSKOPOWE

Odpowiednio wykwalifikowany personel medyczny powinien przeprowadzi¢ doktadne badanie otoskopowe, aby
stwierdzi¢, czy stan ucha jest odpowiedni dla wybranych opcji badania i czy nie ma przeciwwskazan. Te ostatnie
obejmujg niedroznos$é zewnetrznego przewodu stuchowego z powodu nadmiernej ilosci woskowiny i/lub wtoséw, z
ktorych oba musiatyby zostac usuniete. Jest to wymagane, aby dZzwieki dostarczane przez audiometr mogty dotrze¢ do
btony bebenkowej i nie zostaty odbite przez woskowine lub zanieczyszczenia, co mogtoby wptyna¢ na wynik badania.

2.2. ZASADY AUDIOMETRII = CZYSTY TON

Celem audiometrii tonalnej jest pomiar progu styszenia pacjenta, ktory jest nastepnie porownywany z progiem styszenia
osoby przecietnie styszgcej. Badanie rozpoczyna sie od badania na uchu lepiej styszgcym lub, jesli nie okreslono inaczej,
na uchu prawym. BSA (British Society of Audiology) zaleca rozpoczecie testu przy 1000 Hz, aby nastepnie zmierzy¢
wyzsze czestotliwosci. Po zakonczeniu testow z wysokimi czestotliwosciami nalezy ponownie przetestowaé 1000 Hz, a
nastepnie kontynuowac badanie z nizszymi czestotliwosciami.

2.3. PRZYGOTOWANIE DO BADANIA AUDIOMETRYCZNEGO

Zapoznaj sie z réznymi normami audiometrycznymi i innymi odpowiednimi publikacjami, aby uzyskaé¢ wskazéwki
dotyczace badan audiometrycznych.

Warunki otoczenia

Badanie audiometryczne nalezy zawsze przeprowadza¢ w cichych warunkach (np. cichy pokdj lub kabina akustyczna).
Opcjonalne stuchawki wygtuszajace hatas (Audiocups) moga zapewnic¢ dodatkowy poziom izolacji od hatasu otoczenia.
Wiecej informacji na temat dopuszczalnych pozioméw hatasu otoczenia mozna znalez¢ w normie audiometrycznej ISO
6189.

Ustawienie systemu testowania
Ponizszy schemat przedstawia typowy przyktad zastosowania sprzetu do badan audiometrycznych. Audiometr znajduje
sie na biurku siedzgcego operatora, jak pokazano na schemacie.

Computer (e.g. Tablet/Laptop)

Patient, wearing headset \ Operator
Headset lead \ -

— 5O
T =

\ / N._Otosure

Response switch & lead Audiometer

Pacjent siedzi przed biurkiem tytem do operatora. Pacjent ma zatozony zestaw stuchawkowy (patrz ponizej) i odpowiada
na bodzce testowe za pomocg recznego przetgcznika, ktéry jest rdwniez podtgczony do instrumentu.
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ZASADY DZIAtANIA

Stuchawki
Zestaw stuchawkowy musi by¢ dopasowany przez wykwalifikowang osobe, aby zapewnié wtasciwe uszczelnienie i

wygodne utozenie. Przewody z zestawu stuchawkowego sg podtgczane do instrumentu, a nastepnie zestaw
stuchawkowy jest zaktadany na uszy pacjenta.

Instrukcje dla pacjenta
Pacjent otrzymuje nastepujgcy instrukcje: ,,Nacisnij, a nastepnie zwolnij przycisk odpowiedzi, gdy ustyszysz dzwiek”.
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ROZPAKOWANIE | INSTALACIA

3. ROZPAKOWANIE | INSTALACIA

3.1. OGOLNE

Prosze sprawdzi¢ zawartos¢ kartonu wysytkowego z listem przewozowym, aby upewni¢ sie, ze wszystkie zamowione
elementy zostaty dotagczone. Jesli czegos brakuje, nalezy skontaktowac sie z dystrybutorem, ktéry dostarczyt audiometr
lub bezposrednio firmg Amplivox.

Prosimy o zachowanie kartonu i opakowania, poniewaz audiometr wymaga corocznej kalibracji i powinien by¢ odsytany
do firmy Amplivox w oryginalnym opakowaniu wysytkowym.

3.2. OZNACZENIA

Nastepujgce oznaczenia, ktére mozna napotkad:

Symbol Opis
- Type B applied parts. (Zgodnie ze standardem IEC 60601-1)
R Czesci podtaczane do pacjenta, ktére nie przewodzg pradu | mozna je natychmiast odtgczy¢ od
pacjenta.

@ DE Patrz: instrukcja obstugi

WEEE (dyrektywa EU)

Ten symbol oznacza, ze gdy uzytkownik koricowy chce pozbyc¢ sie tego produktu, musi on zostac
wystany do odpowiednich punktéw zbidérki odzysku i recyklingu. Niezastosowanie sie do tego
zalecenia moze stanowic zagrozenie dla srodowiska.

Znak CE wskazuje, ze Amplivox Ltd. spetnia wymagania Zatacznika 1l Rozporzadzenia
dotyczacego wyrobéw medycznych. TUV Product Service, nr identyfikacyjny 0123, zatwierdzit
system jakosci.

Numer seryjny

Data produkcji

Producent

B2 =

L

Y
-

Przechowuj w suchym miejscu

Zakres wilgotnosci podczas transportu i przechowywania

Zakres temperatury w trakcie transportu i przechowywania

=@
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ROZPAKOWANIE | INSTALACIA

M D Urzadzenie medyczne

3.3. INSTRUKCJE BEZPIECZENSTWA
3.3.1. OGOLNE

Podczas obstugi urzadzen elektrycznych nalezy przestrzegaé ogdlnych zasad bezpieczenstwa. Nieprzestrzeganie tych
Srodkow ostroznosci moze spowodowac uszkodzenie sprzetu i obrazenia operatora lub pacjenta.

Pracodawca powinien poinstruowac kazdego pracownika w zakresie rozpoznawania i unikania niebezpiecznych
warunkow oraz przepisdw majgcych zastosowanie w jego srodowisku pracy w celu kontrolowania lub eliminowania
wszelkich zagrozen lub innego narazenia na wszelakie urazy.

Amplivox Ltd. jest Swiadomy, ze zasady bezpieczenstwa w poszczegdlnych organizacjach sg rézne. W przypadku
sprzecznosci miedzy instrukcjami zawartymi w niniejszej instrukcji a zasadami organizacji korzystajgcej z tego
instrumentu, pierwszenstwo powinny mie¢ bardziej rygorystyczne zasady.

Urzadzenie Otosure jest przeznaczone do uzytku przez protetykéw stuchu (tj. laryngologéw, audiologéw), pielegniarki
lub technikéw, ktérzy zostali przeszkoleni w zakresie wtasciwego uzytkowania urzadzenia.

3.3.2. OSTRZEZENIA - OGOLNE

UWAGA

Jesli system nie dziata prawidtowo, nie uzywac¢ go, dopdki nie zostang wykonane wszystkie niezbedne naprawy, a
urzadzenie nie zostanie przetestowane i skalibrowane pod katem prawidtowego dziatania zgodnie ze specyfikacjami
firmy Amplivox.

Nie upuszczac ani w zaden inny sposob nie wywiera¢ nadmiernego nacisku na urzadzenie. Jesli sprzet jest uszkodzony,
nalezy zwréci¢ go do producenta w celu naprawy i/lub kalibracji. Nie uzywac instrumentu, jesli podejrzewane jest
jakiekolwiek uszkodzenie.

Urzadzenie i jego komponenty bedg dziataé niezawodnie tylko wtedy, gdy bedg obstugiwane i konserwowane zgodnie z
instrukcjami zawartymi w niniejszej instrukcji, dotgczonych etykietach i/lub ulotkach. Nie nalezy uzywaé wadliwego
produktu. Nalezy upewni¢ sie, ze wszystkie potgczenia z akcesoriami zewnetrznymi sg odpowiednio zabezpieczone.
Czesci, ktore mogg byc¢ uszkodzone lub ich brak lub sg wyraznie zuzyte, znieksztatcone lub zanieczyszczone, nalezy
natychmiast wymienic na czyste, oryginalne czesci zamienne wyprodukowane lub dostepne w firmie Amplivox Ltd.

Sprzet nie moze by¢ naprawiany przez uzytkownika. Naprawy moga by¢ wykonywane wytgcznie przez autoryzowanego

przedstawiciela serwisu. Zadne modyfikacje sprzetu nie sg dozwolone przez nikogo poza wykwalifikowanym
przedstawicielem firmy Amplivox Ltd. Modyfikacja sprzetu moze by¢ niebezpieczna.
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ROZPAKOWANIE | INSTALACIA

Amplivox Ltd. udostepnia na zadanie schematy obwodow, wykazy czesci sktadowych, opisy, instrukcje dotyczace
kalibracji lub inne informacje, ktére pomogg autoryzowanemu personelowi serwisowemu w naprawie tych czesci tego
urzadzenia, ktére zostaty okreslone przez firme Amplivox Ltd. jako mozliwe do samodzielnej naprawy przez personel
serwisowy.

Zadna cze$¢ urzadzenia nie moze by¢ serwisowana ani konserwowana podczas uzytkowania przez pacjenta.

Do urzadzenia Otosure nalezy podtgcza¢ wytgcznie akcesoria zakupione w firmie Amplivox Ltd. Do urzgdzenia mozna
podtaczac wytgcznie akcesoria, ktére zostaty uznane przez Amplivox Ltd. za zgodne.

3.3.3. CZYNNIKI ZEWNETRZNE

UWAGA

Uzywac i przechowywac instrument tylko w suchych pomieszczeniach. Zaleca sie, aby

‘J

]

? J’ urzadzenie pracowato w temperaturze otoczenia od 15°C / 59°F do 35°C / 95°F i przy
wilgotnosci wzglednej od 30% do 90% (bez kondensacji).

Nie uzywac urzgdzenia w obecnosci ptynu, ktdry moze wejs¢ w kontakt z elementami elektronicznymi lub przewodami.
Jesli uzytkownik podejrzewa, ze ptyny miaty kontakt z elementami systemu lub akcesoriami, nie nalezy uzywa¢d
urzadzenia, dopdki autoryzowany technik serwisowy nie uzna tego za bezpieczne.

3.3.4. BEZPIECZENSTWO ELEKTRYCZNE | ELEKTROSTATYCZNE

Przed wykonaniem jakiejkolwiek czynnosci serwisowej wktadanych stuchawek nalezy

UWAGA odtaczy¢ przetworniki Otosure od pacjenta.

. Nie dotykac jednoczesnie stykdw z tytu instrumentu i pacjenta. Konsekwencja moze by¢
OSTRZEZENIE . .
zbyt duzy przeptyw prad do pacjenta.

Nie otwiera¢ obudowy instrumentu. Serwisowanie nalezy zleci¢ wykwalifikowanemu
personelowi.

Urzadzenie to jest przeznaczone do podtgczenia do innego sprzetu, tworzgc w ten sposéb Medyczny System Elektryczny.
Urzadzenia zewnetrzne przeznaczone do podtgczenia do wejscia sygnatu, wyjscia sygnatu lub innych ztgczy muszg by¢
zgodne z odpowiednig normga produktu, np. IEC 60950-1 dla sprzetu IT i seria IEC 60601 dla elektrycznego sprzetu
medycznego. Ponadto wszystkie takie kombinacje — medyczne systemy elektryczne — muszg spetnia¢ wymogi
bezpieczenstwa okreslone w normie ogdlnej IEC 60601-1, (wydanie 3.1), punkt 16. Wszelkie urzgdzenia niespetniajgce
wymagan dotyczacych pradu uptywu w normie IEC 60601-1 muszg by¢ przechowywane poza otoczeniem pacjenta, tj.
co najmniej 1,5 m od podparcia pacjenta, lub musi by¢ zasilane przez transformator separacyjny w celu zmniejszenia
pragdéw uptywowych. Kazda osoba, ktéra podtgcza sprzet zewnetrzny do wejscia sygnatu, wyjscia sygnatu lub innych
ztaczy, utworzyta medyczny system elektryczny i w zwigzku z tym jest odpowiedzialna za zgodnos$¢ systemu z tymi
wymaganiami. W razie watpliwosci skontaktuj sie z wykwalifikowanym technikiem medycznym lub lokalnym
przedstawicielem. Gdy urzgdzenie jest podtgczone do komputera lub innych podobnych urzadzen, nalezy uwazaé, aby
nie dotyka¢ jednoczesnie komputera i pacjenta.

Urzadzenie separujgce (urzadzenie izolujgce) jest potrzebne do odizolowania sprzetu znajdujgcego sie poza
Srodowiskiem pacjenta od sprzetu znajdujgcego sie w Srodowisku pacjenta. W szczegdlnosci takie Urzadzenie
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ROZPAKOWANIE | INSTALACIA

rozdzielajgce jest wymagane przy nawigzywaniu potfaczenia sieciowego. Wymagania dotyczgce urzadzenia separujgcego
sg okreslone w normie IEC 60601-1, punkt 16.

3.3.5. KOMPATYBILINOSC ELEKTROMAGNETYCZNA (EMC)

Chociaz przyrzad spetnia odpowiednie wymagania EMC, nalezy przedsiewzig¢ srodki
ostroznosci, aby unikngé niepotrzebnego narazenia na pola elektromagnetyczne, np. z
telefonéw komodrkowych itp. Jezeli urzagdzenie jest uzywane w sagsiedztwie innych
urzadzen, nalezy zwrdci¢ uwage, aby nie wystepowaty wzajemne zaktécenia. Wiecej
informacji na temat kompatybilnosci EMC w rozdziale 10.

UWAGA

3.3.6. RYZYKO WYBUCHU

A OSTRZEZENIE NIE uzywaé w obecnosci tatwopalnych srodkéw znieczulajgcych lub innych gazow.

NIE uzywa¢ w obecnosci tatwopalnych mieszanin gazowych. Uzytkownicy powinni
wzig¢ pod uwage mozliwosé wybuchu lub pozaru podczas uzywania tego urzadzenia w
poblizu tatwopalnych gazéw anestetycznych.

NIE uzywaé w srodowisku o duzej zawartosci tlenu, takim jak komora hiperbaryczna,
namiot tlenowy itp.

3.3.7. POMIAR BEZPIECZENSTWA

Aby mie¢ pewnos¢, ze Otosure dziata prawidtowo, przyrzad powinien by¢ sprawdzany i kalibrowany co najmniej raz w
roku. Przetworniki dostarczane z audiometrem sg specjalnie z nim skalibrowane; w momencie wymiany przetwornikdéw
wymagana jest ponowna kalibracja.

Serwis i kalibracja muszg by¢ wykonywane przez autoryzowanego serwisanta. Jesli te kontrole nie zostang
przeprowadzone, moze dojs¢ do naruszenia przepiséw UE dotyczgcych urzagdzen medycznych (MDR) i innych przepisow,
a gwarancja moze zostac uniewazniona.

Uzywanie nieskalibrowanych urzadzen moze prowadzi¢ do btednych wynikéw testu i dlatego nie jest zalecane.

3.3.8. INNE

Uwaga: NIE WOLNO podtgczac sprzetu Otosure do komputera przed zainstalowaniem oprogramowania.

Przechowywanie w temperaturach ponizej 0°C /32°F i powyzej 50°C /122°F moze spowodowaé trwate uszkodzenie
przyrzadu i jego akcesoridw.

Nie umieszczac urzadzenia obok jakiegokolwiek zrddta ciepta.

Podczas obchodzenia sie z przetwornikami nalezy zachowac¢ duzg ostroznos$¢, poniewaz na przyktad upuszczenie na
twardg powierzchnie, moze spowodowac pekniecie lub uszkodzenie czesci.
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Na terenie Unii Europejskiej nielegalne jest wyrzucanie odpadéw elektrycznych i elektronicznych jako
nieposortowanych odpaddéw komunalnych. Odpady elektryczne i elektroniczne mogg zawieraé
niebezpieczne substancje i dlatego muszg by¢ utylizowane oddzielnie. Takie produkty bedg oznaczone
przekreslonym obrazem kosza na kétkach (obrazek po lewej). Wspodtpraca uzytkownikow jest wazna
dla zapewnienia wysokiego poziomu ponownego wykorzystania i recyklingu odpaddéw elektrycznych i
elektronicznych. Brak odpowiedniego recyklingu takich odpadéw moze stanowi¢ zagrozenie dla
srodowiska, a w konsekwencji dla zdrowia ludzi.
Poza Unig Europejskg nalezy przestrzegac lokalnych przepiséw przy utylizacji produktu po jego zakoriczeniu.

3.3.9. KORZYSTANIE Z URZADZENIA PO TRANSPORCIE | JEGO PRZECHOWYWANIE

Przed uzyciem nalezy upewnic sie, ze urzadzenie dziata prawidtowo. Jesli urzadzenie byto przechowywany w zimnym
otoczeniu (nawet przez krotki czas), nalezy zaczekac, az sie zaaklimatyzuje. Moze to zajg¢ wiecej czasu w zaleznosci od
warunkow (takich jak wilgotno$é otoczenia). Kondensacje mozna zmniejszy¢, przechowujgc urzgdzenie w oryginalnym
opakowaniu. Jesli instrument jest przechowywany w warunkach cieplejszych niz rzeczywiste warunki uzytkowania, nie
sg wymagane zadne specjalne srodki ostroznosci przed uzyciem. Zawsze nalezy zapewni¢ prawidtowe dziatanie
instrumentu, przestrzegajac rutynowych procedur kontroli sprzetu audiometrycznego.

3.4. POtACZENIA

Zaciski i ztgcza akcesoridw sg oznaczone, aby zapewnié¢ prawidtowg identyfikacje i podtgczenie w nastepujacy sposéb:

TYP GNIAZDA KOD KOLORU PODLACZONA CZESC
6.3mm jack Niebieski Zestaw stuchawkowy na przewodnictwo powietrzne (lewy) *
6.3mm jack Czerwony Zestaw stuchawkowy na przewodnictwo powietrzne (prawy) *
6.3mm jack Czarny Przycisk odpowiedzi pacjenta
USB Connector N/A Komputer (via USB port)

lj Uwaga: Podtaczaé wytacznie akcesoria dostarczone z instrumentem lub dostarczone przez Amplivox lub
dystrybutora Amplivox. Czesci te zostaty przetestowane do uzytku z audiometrem Otosure pod katem zgodnosci z
normami IEC 60601-1 i IEC 60601-1-2. Uzycie innych akcesoriéw niz okreslone moze zagrozi¢ zgodnosci z tymi normami.

3.5. INSTALACIA SPRZETU

W rozdziale 11 znajdujg sie waine informacje dotyczgce podtjczania niemedycznego sprzetu elektrycznego do
medycznego sprzetu elektrycznego.

Audiometr jest zasilany i kontrolowany przez komputer (PC) za pomoca dostarczonego do tego celu oprogramowania.
Oprogramowanie musi by¢ zainstalowane przed podtaczeniem audiometru do komputera.

Wszystkie inne potaczenia nalezy wykonac przed podtgczeniem audiometru do komputera.

Kabel USB stuzy do podtaczenia Otosure do komputera. Podtgczany port w komputerze musi by¢ zgodny ze specyfikacjg
USB 1.0 lub 2.0. Najpierw nalezy podtaczy¢ zestaw stuchawkowy i przycisk odpowiedzi pacjenta do Otosure, a nastepnie
nawigza¢ potgczenie Otosure z komputerem. Nie jest wymagany okreslony czas nagrzewania, chociaz rejestracja
urzgdzenia na komputerze moze zajgc troche czasu.
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lj Uwaga: W rozdziale 4 znajduja sie instrukcje dotyczace instalacji oprogramowania i sterownikéw, wykonywania
pierwszego potgczenia z komputerem oraz przeprowadzania podstawowej kontroli dziatania, aby upewnicé sie, ze
audiometr dziata prawidtowo.
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4. INSTALACJA OPROGRAMOWANIA | KONTROLA
DZIAtANIA

4.1. OGOLNE

W tej czesci opisano procedure instalacji oprogramowania operacyjnego Otosure i powigzanych sterownikéw urzgdzen,
pierwszego podtgczenia audiometru Otosure oraz przeprowadzenia podstawowej kontroli, w celu upewnienia sie, ze
urzadzenie dziata poprawnie.

4.2. INSTALACIA

Instalacja jest procesem dwuetapowym (upewnij sie, ze oba zostaty zakoriczone):
1. Zainstalowac oprogramowanie Otosure na komputerze
2. Zainstalowac¢ sterowniki urzadzen, aby umozliwi¢ komunikacje USB miedzy komputerem a audiometrem
Otosure

Krok 1: Instalacja oprogramowania Otosure
Instalacja oprogramowania Otosure przebiega automatycznie i jest instalowana jako czes¢ Audibase. Instrukcje instalacji
krok po kroku znajduja sie w instrukcji obstugi Audibase5.x.

Krok 2: Instalacja sterownikéw USB
Zapoznaj sie z,,D-0115682" Instrukcjg dotyczacg instalacji sterownikéw USB Amplivox

4.3. ODINSTALOWANIE PROGRAMU OTOSURE

Odinstalowanie programu Otosure odbywa sie po prostu przez przejscie do lokalizacji, w ktérej oprogramowanie zostato
pierwotnie zainstalowane i usuniecie pliku o nazwie ,Otosure.exe”. Nie ma potrzeby uzywania narzedzia ,,Dodaj lub
usun programy”.

Aplikacja Audibase pozostanie zainstalowana.

lj Informacja: Jesli potrzebne jest wiecej informacji na temat odinstalacji Audibase, prosze zapozna¢ sie z instrukcjg
obstugi Audibase5.x.

4.4. KONTROLA DZIAtANIA

Podtaczyé stuchawki i przycisk odpowiedzi pacjenta do audiometru Otosure a nastepnie podfgczy¢ Otosure do
komputera za pomocg kabla USB. Uruchomi¢ aplikacje Audibase na komputerze i wprowadzi¢ dane nowego pacjenta
(patrz: instrukcja obstugi Audibase).

-,@ Rozpoczac test za pomocy przycisku Launch Test na pasku narzedzi Audibase

ﬁ\[ﬂ'll Zamknac¢ wszystkie okna dialogowe w oknie Otosure i wybraé opcje Manual Test
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Przesung¢ wskaznik myszy nad ikone ,Present” w oknie Otosure i upewni¢ sie, ze stycha¢ dzwiek w stuchawce. Uzy¢
klawiszy strzatek na klawiaturze komputera, aby zmieni¢ poziom i czestotliwos¢ tonu. Uzy¢ klawiszy ,L” i ,R” na
klawiaturze komputera, aby przetgczaé sie miedzy stuchawkami.

Nacisng¢ przetgcznik odpowiedzi pacjenta i upewnic sie, ze ikona ,Response” w oknie Otosure zmienita kolor na
jasnozielony i powrdcita do ciemnozielonego po zwolnieniu przycisku pacjenta.

Powyzsze zademonstruje podstawowg funkcjonalno$¢ audiometru. Podczas zamykania okna Otosure pamietac, aby
uzy¢ opcji ,Edit > Cancel Insert/Edit” lub anuluj przycisk paska narzedzi w Audibase, aby anulowaé wykonanie testu.
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5. UZYTKOWANIE OTOSURE

5.1. PRZYGOTOWANIE URZADZENIA

Podtgczyé zestaw stuchawkowy i przetgcznik reakcji pacjenta do Otosure, a nastepnie podtagczy¢ Otosure do komputera.
Rozgrzewanie urzadzenia nie jest wymagane, chociaz rejestracja urzgdzenia na komputerze moze zajac¢ troche czasu.

5.2. URUCHAMIANIE OPROGRAMOWANIA

Uruchomié aplikacje Audibase i zgodnie z instrukcji obstugi utworzy¢ nowego pacjenta lub uzyskac dostep i wyswietli¢
szczegOty istniejgcego pacjenta.

.,@ Uzy¢ lewego przycisku myszy, aby klikngé ikone Launch Test na pasku narzedzi Audibase

Alternatywnie uzy¢ menu rozwijanego ,Test > Launch test” w gérnej czesci okna

Otworzy sie nowe okno oprogramowania Otosure. Jesli pacjent ma wiecej niz jeden zestaw wynikéw audiometrycznych
zapisanych w Audibase, najnowszy audiogram jest przesytany i wyswietlany w oknie Otosure.

Numer seryjny i data kalibracji podtgczonego audiometru Otosure sg wyswietlane w prawym dolnym rogu okna Otosure
wraz z aktualnie wybranym typem badania.

Zapamietywany jest ostatnio uzywany typ testu; jesli byt to test manualny, mozna postepowac zgodnie z procedurami;
jesli byt to test automatyczny, zostanie wyswietlone nastepujgce okno dialogowe:

[ Run Test? . 3] Aby uruchomic ten sam automatyczny test przy uzyciu tych samych opcji (jak
poprzednio), wystarczy klikng¢ przycisk ,Start test”, a test sie rozpocznie.

Fiur test, ar modify test settings?
Jesli wymagany jest test reczny lub jesli opcje testu majg zostac
zmodyfikowane, klikng¢ przycisk ,,Modyfy”, ktéry zamknie okno dialogowe

[ Start test_ Modity

5.3. DOSTEPNE TRYBY TESTOWE
5.3.1. TESTOWANIE MANUALNE

Dzieki temu operator moze uzywac Otosure do rejestrowania progdw poziomu styszenia za pomoca klawiatury i myszy
komputera. Otrzymane dane audiometryczne mozna nastepnie przenies¢ do aplikacji Audibase.

5.3.2. TESTOWANIE AUTOMATYCZNE

Jest to metoda automatycznej audiometrii oparta na metodzie Hughsona i Westlake'a, wykonywana automatycznie
przez urzgdzenie. Poziom jest zwiekszany w krokach co 5 dB, az do uzyskania odpowiedzi od pacjenta i zmniejszany w
krokach co 10 dB, az do braku odpowiedzi. Proces jest powtarzany az, w zaleznosci od kryteriow wybranych do rejestracji
progu, przyrzad zarejestruje prog przy tej konkretnej czestotliwosci. Nastepnie Otosure przechodzi do nastepnej
czestotliwosci testowej i tak dalej, aby zakonczy¢ test na obu uszach.
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Otosure zapewnia mozliwos¢ przeprowadzenia tego testu przy okreslonych pojedynczych czestotliwosciach i dodania
wynikéw do ogdlnego wyniku audiogramu. Ta funkcja jest przydatna w sytuacjach, gdy jedna konkretna czestotliwos¢
okazata sie problematyczna.

5.3.3. TESTOWANIE MIESZANE

Jest to metoda stosowane zwykle, gdy test automatyczny nie byt w stanie okresli¢ wartosci progowej dla jednej lub
wiecej czestotliwosci. Mozliwe jest wykonanie testu recznego (zwykle tylko na kilku wybranych czestotliwosciach) w
celu uzupetnienia audiogramu poprzez dodanie progdéw do juz ustalonych.

5.4. PRZYCISKI STERUJACE

uruchamia wybrany test automatyczny

wybdr testowania komputerowego

wybér testowania manualnego

wybdr wyswietlania szczegdtdw testu

wybdr wyswietlania audiogramu

Wydany zostanie dzwiek testowy w trybie testu recznego, gdy wskaznik myszy zostanie przesuniety
nad te ikone; nie ma potrzeby klikania przyciskiem myszy

lkona zmienia sie na ten format, gdy prezentowany jest dzwiek

'j Informacja: Prezentowana ikona bedzie réwniez wyswietlana podczas automatycznego
testowania, chociaz uzycie myszy w sposéb opisany powyzej nie przyniesie zadnego efektu podczas
automatycznego testowania.

Przycisk odpowiedzi pacjenta, wyswietlany w ten sposéb, gdy pacjent nie odpowiedziat

lkona zmienia sie na ten format po udzieleniu

5.5. STEROWANIE —Z KLAWIATURY | MYSZA

Klawiatura, klawisz “L”: wybodr lewego ucha przy testowaniu manualnym

Klawiatura, klawisz “R”: wybdr prawego ucha przy testowaniu manualnym

Klawiatura, klawisz T zwiekszanie poziomu dzwieku w trybie testu manualnego

Klawiatura, klawisz $: zmniejszanie poziomu dZzwieku w trybie testu manualnego

Klawiatura, klawisz «<—:  wybieranie nizszej czestotliwosci tonu w trybie testu manualnego

Klawiatura, klawisz —: wybieranie wyzszej czestotliwosci tonu w trybie testu manualnego

Mysz, wskaznik: emitowanie dzwieku testowego, gdy znajduje sie nad biezgcg ikong w trybie testu
manualnego
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Mysz, lewy przycisk:
Mysz, prawy przycisk:

UZYTKOWANIE OTOSURE

wybdér normalnych opcji opartych na systemie Windows
wykreslanie wartosci progowej — tylko w tescie manualnym

5.6. TESTOWANIE MANUALNE

Klikng¢ przycisk Manua

| test < (przycisk zostanie podswietlony)

Alternatywnie uzy¢ menu rozwijanego ,Test > Manual” w gérnej czesci okna Otosure. Wyswietli sie nastepujgcy ekran:

Edt Test View Options Pause About
€ WKl BN
, JL D ,
Previous Previous
| L | | | L | | | | | | L |
Current Current
| | | | | | | | | | | | | | | | |
125 250 500 1K 1K5 2K 3K 4K 6K 8K dBHL 125 250 1K 1K 2K 3K 4K 6K 8K
.................................. A0 Fe
.................................. 0
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, 10 b
,,,,,,,,,, g R
T R TTRTISR RIS SRR E 11 S
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, .
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, i |
.................................. Bl e
.................................. sy R
.................................. B0 beeoeeoeeeeees
.................................. i e
rrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrr T
rrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrr MO b
----------------------------------- 120 keeeecocoeeeneeeeees
LEFT RIGHT
idle [ KAz 30 dBHL | [ Connected to 1,Cal date 27/3/2012 | [ Manual

Zwrdci¢ uwage na kursor umieszczony w obszarze audiogramu lewego ucha, wskazujgcy biezgcg czestotliwosé i wartosé
dBHL (rowniez wyswietlane w dolnej Srodkowej czesci okna Otosure).

Najechanie myszka na ikone ,Present” - spowoduje wyemitowanie zalecanego tonu na tym poziomie i

czestotliwosci z lewe;j st

Jesli pacjent nacisnie pr

uchawki, a ikona ,,Present” zmieni sie na ¥

jasnozielony E

zycisk odpowiedzi, ikona ,Response” zmieni kolor z ciemnozielonego na

Aby zmieni¢ poziom prezentowanego tonu, uzyj klawiszy strzatek Tid naklawiaturze komputera.

Po upewnieniu sig, ze uzyskano spdjng odpowiedz na okreslonym poziomie, prog mozna wykresli¢ na ekranie, klikajgc
prawym przyciskiem myszy. Warto$¢ liczbowa progu jest dodawana do odpowiedniego pola tekstowego nad
audiogramem. Jesli popetniono btad, po prostu wykreslenie innego progu przy wybranej czestotliwosci zastgpi
poprzedni prog.
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Aby usunac¢ wszystkie progi z audiogramu, nalezy uzy¢ menu rozwijanego , Test > Clear readings...” i wybra¢ odpowiednie
pozycje do usuniecia.

Aby zmienié czestotliwos¢ prezentowanego tonu, uzyj klawiszy strzatek «<— and — na klawiaturze komputera. Kontynuuj
wykreslanie progdw, az wszystkie pozgdane czestotliwosci zostang przetestowane.

Aby wybraé prawe ucho, nalezy uzy¢ klawisza ,R” na klawiaturze komputera, a aby powrdci¢ do lewego ucha, uzyc
klawisz ,,L”.

Aby utworzy¢ kompletny audiogram dla pacjenta nalezy uzy¢ opisanych powyzej elementdéw sterujgcych,. Po
zadowalajgcym zakonczeniu klikngé¢ , Exit” w gédrnym rogu okna Otosure i potwierdz wyjscie z Otosure. Okno Otosure
zamknie sie, a okno Audibase wyswietli wyniki testu. Prosze zapoznac sie z instrukcjg obstugi Audibase, aby uzyskac
dodatkowe opcje, ale nalezy zauwazy¢, ze wyniki muszg zostac zapisane w Audibase, aby zostaty zachowane w bazie
danych.

5.7. TESTOWANIE AUTOMATYCZNE

Klikng¢ przycisk Computer (przycisk zostanie podswietlony)

A

Alternatywnie mozna uzy¢ uzyj menu rozwijanego , Test > Computer” w gornej czesci okna Otosure. Wyswietlany jest
ekran, ale z usunietg ikong ,,Present” i kursorem.

Aby przeprowadzi¢ petny test automatyczny na obu uszach, wystarczy klikng¢ przycisk ,,Run selected test”.
=
€ |

Alternatywnie mozna uzy¢ opcji menu rozwijanego , Test”, aby wybraé petne badanie lub ograniczone badanie (na
przyktad ograniczone do jednego ucha).

Test automatyczny zostanie uruchomiony zgodnie z wybranymi opcjami testu ze stanem testu wskazanym w lewym
dolnym rogu okna Otosure. lkona ,Present” pojawi sie ponownie i bedzie wskazywaé, kiedy dzwieki zostanag
wyemitowane, a ikona ,,Response” zmieni kolor na jasnozielony, gdy pacjent zareaguje.

|u,

Aby zobaczy¢ prezentowane tony nalezy wybrac przycisk ,,Show test detai

=

Alternatywnie mozna uzy¢ opcji menu rozwijanego ,View > Detai

|n

Aby wyswietli¢ progi audiogramu, wybierz przycisk ,Show audiogram”:

Y

Alternatywnie mozna uzy¢ opcji menu rozwijanego “View > Audiogram”.

Kolejnosc¢ testowanych czestotliwosci, przy zatozeniu, ze wybrano wszystkie czestotliwosci, to 1kHz, 1.5kHz, 2kHz, 3kHz,
4kHz, 6kHz, 8kHz, 500Hz, 250Hz i 125Hz.

Czas, jaki pacjent ma na odpowiedz, to czas od momentu, w ktérym ustyszymy dzwiek, do poczatku nastepnego dzwieku

(maksymalnie okoto 2,3 sekundy). Jesli odpowiedz zostanie udzielona w tym czasie, do czasu, jaki uptywa do nastepnego
tonu, dodawane jest losowe opdznienie.
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Po pomysinym zakonczeniu testu zostanie wyswietlone nastepujace okno dialogowe:

F ™
Automatic Test Finished g

Test sequence completed sucesshull
Continue further testing, or accept results?

Jesli test nie zakonczyt sie pomysinie, zostanie wyswietlone nastepujgce okno dialogowe:

F B
Automatic Test Finished u

Test zequence complete with errars
Continue further testing, or accept results?

Aby zaakceptowac wyniki i przenies¢ je do Audibase, klikng¢ przycisk ,Accept”. Okno Otosure zamknie sie i zostanie
wyswietlone okno Audibase. Aby uzyska¢ dodatkowe opcje nalezy zapoznac sie z instrukcjg obstugi Audibase. Trzeba
rowniez pamietac, ze wyniki muszg zostac¢ zapisane w Audibase, aby zostaty zachowane w bazie danych.

Aby kontynuowac testowanie, klikng¢ opcje ,,Continue”. Okno dialogowe zostanie zamkniete, a operator bedzie mdgt
kontynuowac testowanie zgodnie z opisem w tych podsekcjach.

5.8. BADANIE NA JEDNEJ CZESTOTLIWOSCI

W trybie testu automatycznego mozliwe jest przeprowadzenie testu z jedng czestotliwoscia. Na przyktad, gdy operator
zauwazyt, ze reakcja pacjenta przy okreslonej czestotliwosci byta nieprawidtowa lub test automatyczny nie byt w stanie
ustali¢ odpowiedzi przy okreslonej czestotliwosci.

Opcja ,Test > One freq. test” mozna wykorzysta¢ do wybrania pojedynczej czestotliwosci dla konkretnego ucha.

Klikniecie wymaganej opcji czestotliwosci i ucha inicjuje badanie, ktére nadpisze wszelkie dane audiometryczne juz
ustalone dla tej czestotliwosci. Na koniec testu prezentowana jest opcja ,,Continue” lub , Accept”.

5.9. TESTOWANIE W TRYBIE MIESZANYM

Tryb ten pozwala na uzupetnienie audiogramu poprzez wykonanie testow (zwykle na kilku wybranych czestotliwosciach)
przy uzyciu alternatywnego typu testu. Na przyktad, funkcja ta moze by¢ wykorzystana do przeprowadzenia testu
manualnego, jesli opcja testu automatycznego nie byta w stanie ustali¢ progu przy okreslonej czestotliwosci.

Oznaczenie ,,Mixed” jest wyswietlana w prawym dolnym rogu okna Otosure.
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6. OPCJE MOZLIWE DO SKONFIGUROWANIA

6.1. OGOLNE

Oprogramowanie Otosure przechowuje ostatnio stosowang konfiguracje testu i poczgtkowo uzyje jej do
przeprowadzenia kolejnych testow. Dostepnych jest jednak wiele opcji konfigurowania, modyfikowania i kontrolowania
testu. Zostaty one podsumowane ponizej — patrz okno operacyjne oprogramowania Otosure.

6.2. POLECENIA MENU

Exit: spowoduje to zamkniecie okna Otosure i przestanie znalezionych progéw audiometrycznych oraz innych
szczegotow testu do Audibase, jesli uzytkownik potwierdzi czynnosc

Test: zapewnia to dostep do szeregu elementdw sterujgcych w nastepujacy sposdb:

e  Uruchamia petny test (testuje kazde ucho po kolei przy uzyciu biezgcego typu testu automatycznego)

o Left test (testuje tylko lewe ucho przy uzyciu biezgcego typu testu automatycznego)

e Right test (testuje tylko prawe ucho przy uzyciu biezgcego typu testu automatycznego)

e One freq. test (testuje wybrang kombinacje uszu i czestotliwosci przy uzyciu biezgcego typu testu
automatycznego)

e Stop test (wysSwietla kolejng opcje potwierdzenia lub anulowania polecenia ,Stop test”; test jest
kontynuowany do czasu uzyskania odpowiedzi; jesli ,Stop test” zostanie potwierdzony, wszelkie znalezione
wartosci progowe zostang zachowane)

e  Wyczys¢ odczyty (usuwa wszystkie audiogramy i dane progowe lub tylko dane dla lewego lub prawego ucha

e Computer (ustawia Automatyczny jako biezgcy typ testu automatycznego)

e Manual (ustawia audiometr w trybie testu Manualnego)

|n

View: pozwala na wybor widoku testu ,,Detail” (graficzne przedstawienie prezentowanych tonéw i odpowiedzi

pacjenta) lub ,,Audiogram” (wykresy znalezionych progéw)

Options: spowoduje otwarcie okna dialogowego, ktdre zapewnia dostep do nastepujacych opcji:

o Dostepne jest wideo przedstawiajgce sposob korzystania z roZznych ustawien testu

e Frequencies — wtgcza lub wytgcza 125Hz, 250Hz, 1.5kHz or 8kHz do/z procedury testu
e Computer test — zezwala:
o wybdr2z3lub3z5spdjnych odpowiedzi w celu wygenerowania waznego progu
o pominiecie ponownego testu czestotliwosci 1kHz (wtgczenie tej funkcji moze okazaé sie przydatne w
korelacji wynikow testéw)
e Tone response - okreslenie dziatan, ktére nalezy podja¢ w przypadku btedu:
o ile razy czestotliwos¢ jest powtarzana (0, 1, 2 lub 3 razy) w przypadku wystgpienia btedu w badaniu
(na przyktad w przypadku btednej odpowiedzi pacjenta)
O a nastepnie dziatanie, ktore nalezy podjac, jesli btad bedzie sie powtarzat (pomin czestotliwos¢ lub
wstrzymaj test)
e  Start level - okresl poziom poczatkowy 20 dBHL, 30 dBHL lub 40 dBHL dla testu i dla wszystkich czestotliwosci
1 kHz i nizszych dla testu automatycznego
e  Start with familiarisation - zapoznanie sie z czestotliwoscig 1 kHz przed badaniem
e Beep on finish - emituje dZzwiek ostrzegajacy operatora o zakoniczeniu testu

Pause: natychmiast wstrzymuje test i wyswietla dalsze opcje, aby przerwad test, ponowic testowang czestotliwos¢ lub

zignorowac biezgcg czestotliwosc i przejs¢ do nastepnej (opcja nie stosowana dla testu manualnego); jesli test zostanie
przerwany, wszelkie znalezione wartosci progowe zostang zachowane
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OPCJE MOZLIWE DO SKONFIGUROWANIA

About: wyswietla informacje na temat wersji oprogramowania Otosure zainstalowanego na komputerze oraz adres e-
mail pomocy technicznej
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ROZWIAZYWANIE PROBLEMOW

7.ROZWIAZYWANIE PROBLEMOW

7.1. OGOLNIE

Otosure jest prosty w uzyciu dzieki intuicyjnemu interfejsowi uzytkownika, a jesli postepuje sie zgodnie z instrukcjami,
proces testowania powinien byc tatwy. Produkt zostat zaprojektowany w celu wykrywania i zgtaszania szeregu btedéw,
ktore moga wystgpic podczas przeprowadzania badan audiometrycznych i s3 one opisane ponizej.

7.2. NIE ZNALEZIONO INSTRUMENTU

Jesli audiometr nie zostat podtaczony, gdy Audibase zazgdato testu, oprogramowanie Otosure nie uruchomi sie i
zostanie wyswietlone nastepujgce okno dialogowe z ostrzezeniem:

—_' A
Communication Errol

Instrument not found

Error 2 type d

Klikniecie OK spowoduje powrdt do Audibase.

Uzy¢ opcji ,Edit > Cancel Insert/Edit” lub anulowa¢ przycisk paska narzedzi, aby anulowaé operacje wstawiania.
Nastepnie mozna podtgczy¢ Otosure i kontynuowac dziatanie.

7.3. BRAK ODPOWIEDZI OD PACIENTA

Jesli audiometr wykryje, ze pacjent nie reaguje na ton testowy podczas testu automatycznego, poziom tonu wzrosnie
do maksimum, a nastepnie badanie zostanie wstrzymane, a na ekranie komputera zostanie wyswietlony nastepujacy
komunikat:

Mo patient response I—-i.a—l

—

@ Stop test, retry frequency or continue?

Betry Ignore

W zaleznosci od okolicznosci operator moze przerwac test, powtdrzy¢ cze